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BHKL-2023 %,
Do not open the Seal of the Question Booklet until you are askedto - !”—l |
\ : 4
Question Booklet Code: B ‘ Question Booklet Series No: | . ‘ l
. ' v . . l
Time Allowed: 150 Minutes Total Questions; 150 . Maximum Marks: 150

There shall be negative marking @ 0.25 mark per question for wrong/multiple answers

- Before answering any question, check the booklet that it contains 16 pages and no page is missing,
mutilated or repeated. In case of defect, get it replaced immediately.

“INSTRUCTIONS FOR CANDIDATES

1. Fill in the OMR answer sheet, mentioning the Roll No. and other data as required in the place(s)
indicated therein. Darken the appropriate circles in blue or black ball point pen only. Do not write
any name / surname or put any symbol sign, slogan, prayer or any mark of identification in the
OMR answer sheet. Do not tampér with the bar-code or any other portion of the OMR answer sheet.
Any such act is liable to render the answer sheet unfit for evaluation. ’

2. Correcting fluid, eraser, blade, books, textual material, script notes / loose paper calculator
document, slide rules, log tables / electronic watches, smart watch, cell phone, pager, other
electrical/ electronic devices etc, are not allowed inside the examination hall. In case the candidate
is found to be.in possession of any of the above, he / she shall be expelled from the examinatior
without any enqunry as to whether the same was / were used by the candidate or not. '

'IVHS

3. A machine will read the coded information. furnlshed by you in the OMR .Answer Sheet. If th
information so furnished by you is mcomplete or different from what you have glven in the™ T\~
application form, you shall be awarded Zero mark.’ e

4. Answer must be given by completely darkening one of the four circles / ovals representlng the most
appropriate answer given on the Answer Sheet correspondlng to the relevant question. For answers
not shown by properly darkenmg in black / blue ba[l point pen, no marks shall be awarded.

5. No Rough work shouild be done on the OMR Answer Sheet Space for rough work has been provided
in the Question Booklet ltself : :

6. After the examination is over, candidates must ensure to fold the OMR Answer Sheet at the

~perforation and separate the Original Copy and Candidate’s Copy of the Two Part OMR Answer

Sheet in the presence of the Invigilator and handover the Original Copy to the Invigilator. The

Candidate’s Copy of the OMR Answer sheet may be taken by the candidate. Failure to hand over

the original copy of the OMR Answer Sheet to the Invigilator before leaving the examination hall /
room shall make the candidate liable for penal action. ’ -

7. Candidates may take with them the respective questlon booklet after the examination is over.

8. Failure to comply with or violation of any of the above instructions shall be consndered as adopting
unfair means and action as deemed proper shall be taken.
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CURRENT AFFAIRS

1. Where is India’s largest fac111ty for weightlifting
coming up?

a) Ganjam

b) Imphal

¢) New Delhi
d) Bhubaneswar

2. Who won the Best Actress award at Cannes Film
Festival 2024 for acting in ﬁlm “The shameless’
(royal section)?

a) Kani Kusruthi

b) Anasuya Sengupta

c) Divya Prabha

d) Chhaya Kadam

3. Naomi Osaka, famous tennis player returned to
"WTA Tour after a break in J anuary 2024. Why d1d
she take the break?

a) Injury
| b) Mental health issues
| c¢) Financial issues
i. d) Legal issues (court case)

' 4 Ameen Sayani died in February 2024 In whmh
field d1d he earn his fame?

’ a) Radio annouhcerhent
| -b) Singing

\ c) TV Anchor

d) Film D1rector '

period was he’ spedker of the Lok Sabha y

a) 2002 to 2004
b) 2004 to 2006
c) 2000 to 2002
d) 1995 to 2000

6. Who is the Sohcn;or General of Indla? e

a) Tushar Mehta

~b) Ranjit Kumar

¢) Mohan Parasaran

d) Gopal Subramanyam A

7. Who is the current Chairman.of Secunty and.
Exchange Board of India?

a) Madhabi Puri Buch
b) V.K Sinha '
c) Ajay Tyagi
d) C.B Bhave

. resignation in end Februa

5. Manohar Joshi di &.d in February ’7024 For whlch

GET IT ON
Google Play

o T

8. Who is the chief of Army Staff in June, 20247 |

a) General Manoj Pande

b) General Manoj M. Naravane
c¢) General Dalbir Singh Suhag
d) General Rakesh Kapoor

9. Who is the pres1dent,of Pakistan?

a) Asif Ali Zardari
b) Imran Khan

¢) Nawaz Sharif
d) Shahbaz ‘Sharif

10. Palestlman Prime Minister declared his
ry and laid down office on

318 march 2024. What is his name?

a) Mohammad Shtayyeh
b) Rami Hamdallan

- ¢) Salam Fayyad

d) Yehia Sinwar

11. Who is the new Prime Minister of Singapore?

- a) ‘Lawrence Wong
‘b) Lee Kuan Yew
c) Gok Chok Tong
d) Lee Hsien Loong

' 12 Alice Munro died in May 2024. In which field
'did she earn her fame? -

a) therature
b) Acting
* ¢) Painting
d) POllthS

' 13. Director of “All We Imagme as Light” won the

Grand Prix at Cannes Film Festival 2024. Who is

. the Director of the film?

a) Sanjay Leela Bhansali
b) Payal Kapadia

- ¢)  Mani Ratnam-
d) Anurag Basu -

S 14 New laws replacing IPC Cr PC and IEA will |
~ come into effect on:

a) July 12024

b) June'l 2024

c) 31 December 2024
d) 1 January 2025

15. Result of votes counting in which election was .
set aslde by Supreme Court in February 20249

BHKL/Eng/B-2
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l';; g:ec‘t!on for M-ayor of Ch'andigarh. c) Sputnik —V
cction of Rajya Sabha in Uttar Pradesh d) Janssen
c) Election of MLA in a recent election.
d) Election of Rajya Sabha in Himachal 23. Which is India’s largest Lok Sabha constituency
Pradesh. in terms of voter population?
16. Cyclone *REMAL’ made landfall in end May. a) Malkajgiri
Which country was most affected by ‘REMAL’? b) Outer Delhi
a) Bangladesh c) Agra
b) Myanmar | d) Khurda
3)) ;hlallj::ga | - 24, Papua New Guinea was affected by a natural

disaster in May 2024 resulting in death of over a

' ‘thousand. What was the nati i
17. How many MLAs are elected for Odisha ¢ national disaster?

Legislative Assembly? a) Cyclone
\ ' b) Flood
E)) }i; c) Landslide
¢ 157 d) Earthquake
d) 142

25. In Archery World Cup, held recently at

18. Who is the present Clﬁef Minister of Goa? ‘Shanghaﬁ, Indian Wom.e n’s team won Gold Medal.
: Whom did they defeat in final?
a) Pramod Sawant |

b) Digambar Mamat a) Turkey
¢) Laxmikant Parsekar , , b). France :

'd) Francisco Sardinaa c) ltaly
d) South Korea :

19. What is the name of Slovakia Prime Minister

who was attacked in May 20247 | 26. Alejandra Bodrigue.z, a Ia}vyer and joumal'ist
: L recently won title of Miss Universe Buenos Aires.
a) Peter Pellegini i '  ~What was her age at the time of winning the title? |
b) Robert Fico : a) 27 - B E s
c) Eduard Heger RS & . b) 45
d) Ludovit Odor ' : : c) 25
20. Who is the Chairman of DRDO and Secretary of 9 B

Department of Defence Research & Development? 27. A biopic ‘Chamkila’ was made on life of Amar
: a) Dr Samir V. Kamat - wdd Singh Chamkila. In what field did late Mr. Amar
: . ? . . -
b) ShriS. Christophar Singh Chamkila earn his fame?

c) DrV.S Arunachalam - B “a) Singing

d) Literature

d) Dr.G. Satheesh Reddy ‘ ~b) Sports
* 21. Who is the Director General of CSIR and ElpincE

Secretary of DSIR?

a) Dr. (Mrs) N Kalaiselvi
b) Dr. R.A Mashelkar

28. In India Super League, whom did Odisha FC
face in semifinal in April 20247

¢) Dr. Sekhar C Mande : a) Mohan Bagan
d) Dr. Girish Sahani s " b) Mumbai city
' : epac G B T c) KeralaBlasters
22. Which Covid vaccine manufacturer admitted in - d) Goa

UK Court that said vaccine can in rare cases cause
“Thrombosis with Thrombocytopenia syndrome”? 29. Who is the Captain of Kolkata Knight Riders,
' oy who won IPL Championship in'2024?
a) Astra Zeneca/Covishield a) Shreyas lyer

b) Covaxin . b) Andre Russel
BHKL/Eng/B-3
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c) Phil Salt
d) Varun Chakravarthy

30. Who has been awarded Gyanpith Puraskar for
20237

a) Gulzar

b) Rambhadracharya

c) Botha&b

d) None of the above
31. India’s top Cargo handling port for 2023-24
was:

a) Paradeep Port

b) Kandhra Port

c) Vizag Port

d) JNPA Port :
32. As per recent amendment made in Section 14
(b) of Representation of People Act, how many
qualifying dates have come into effect, in place of
one qualifying date, for voter registration?

a) 2 o

b) 3 '

c) 4

d) 5

33. On which date is National Voters Déy !
celebrated in India? ’ ' P

a) 24 January
b) 25 January -
c) 26 January
d) 26 February

34. As per new initiative by ECI, senior citizens -

above certain age can vote from home. What is that

age?

a) Above 80 years : : .
‘b) Above 85 years - ‘ e Ll
‘c) Above 75 years : ‘

d) Above 82 years .

35. ECI has approved 12 alternative identity
documents in place of Voter Identity Card for
identity verification at Polling Booth. Which of the
following is not one of them? .
: a) PAN Card
, b) AADHAR Card
c¢) Credit Card
d) Driving license

36. What percentage of booths are covered for
webcasting by ECI? -

a) 30%

b) 40%

GET IT ON
Google Play

c) 50%
d) 60%

37. What is the total electors of Odisha as on 28.4,

20247

a) 33236360
b) 733646762
¢) 16850949
d) 32210723

38.In how maﬁ)'/ phases has General Election 2024 -

been conducted in Odisha?
a) 3 Phases
b) 4 Phases
c) 5 Phases
- d) 2 Phases

39. Prime Minister of Greece paid state visit to
India in March 2024, What is his name? ‘
a) Kyriakos Mitsotakis -
b) Alexis Tsipras
c) loannis Sarmas
d) Kostis Hatzidakis

" 40. Kolkata Knight Riders won IPL title in 2024.

Who did they defeat in the finals?

a) Mumbai Indians

b) Sunrisers Hyderabad . .

¢) Royal Challengers Bengaluru
- - d) Rajasthan Royals ’

DATA INTERPRETATION
Directions (Q 41-45) Study the following
information carefully and answer accdf_dingly.
Note: Use additional information given in any

~ question or its answer for answering subsequent

questions.
| Geography (67) | LG Economics
English

BHKL/Eng/B-4
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41. How many students study Geography or
English?

a) 108

b) 91

c) 62

d) 130

42. 1f 32 students study only Geography, how many
students study English?

a) 63

b) 67

¢) 52

d) 59

43. How many students study Economics or
Geography or both but not all three?

a) 28

b) 90

c) 68

d) 54

44. How many students study only Economics?
a) 15 '
b) 16
c) 17
d) 18

45. What is the total number of students enrolled for
studying these three subjects, either one of them,
two of them or all of them? ‘ ’

a) 120 :

b) 130 -

c) 123

d) 132

Directions (Q.46-50) Study the table given below

and answer the following questions. The table gives -
" the details about bowling performances of six

bowlers. o
Bowlers | Overs | Maidens | Runs Wickets
_ . Conceded | Taken
Lee 20 5 120 15
Bond [ 18 4 72 9
Steyn -- 6 - . 20
Asif 12 a == -
Amir 24 = - 32
Roch 16 3 96 20

Note: Maiden over is one ‘in which a bowler doesn’t
concede any run.

GET IT ON
Google Play

; 2
46. If the number of wickets taken by Asif is 16 3%

of total number of wickets taken by all the
remaining bowlers and he conceded 7 runs per overs
then find his strike-rate. (Strike rate is defined as the
no. of runs conceded per wicket)

a) 5.25

b) 4.25

c) 6.25

d) 7.25

47. How many more maiden overs should Roch
have bowled in order to equal the economy rate of
Bond? (Economy rate is defined as the no. of runs
conceded per over)

a)4

b) 6

c)2

d)8

48. If Amir bowls a maiden for every 3 overs he

~ bowls and concedes 33 %% more runs that Lee did

* then find the ratio of his maidens per wicket to the

runs conceded by him per overs?
' a) 5:71
b) 3:71
~¢)3:80
d) 5:81

| 49. If Lee and Steyn collectively bowled 36 overs

-and conceded 280 runs; then find the ratio of their
strike rates. (Use information from previous

* questions if needed)

a) 2:1
bj 1:1
c)3:1.
d) 1:4

© 50. Strike-rate of Amir is what percentage of the

economy rate of Roch? (Use information from
previous questions if needed) -

a) 90%

b) 83.33%

c) 85.25%

d) 88.75%

BHKL/Eng/B-5
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Directions (Q 51-55): Read the given data carefully
and answer the given questions.

Given below is the table which shows the different
types of work A, B, C, D and E; ratio of efficiency
to do these works, of a man, a woman and a child
respectively and total time taken by a child to
complete these different works. -

Time Taken by a child

Work Ratio of
efficiency to complete work.
- (M:W:C) P
A 5:3:4 20 days
B L 4:3:2 10 days
C 8.7:6 .21 days
D 3:2:1 15 days
E 6:4:3 16 days

51. What is the time taken to complete work A by 3
men, 2 woman and.1 child together? ;
a) More than 4 days
b) More than 5 days
¢) More than 3 days
- d) More than 6 days

52. What is the time taken by a Man to complete :

~Work B?
- a)4 days
. b)10days
c) 5 days
d)6 days

53. In how many days can 2 men, 3 women and 3 i

children complete work D?
. a) 6 days - . ;
b) 4 days -
c) 3 days
‘d) 1 day

GET IT ON
Google Play

Directions (Q. 56-60): Study the given information ¢!

and answer the following questlons

There are three types of vehlcles ie., 3 Auto,4 Car
and one Truck which take rides every day Distance
covered by each type of vehicle per ride is same.
Profit per ride of an Auto and a Car is given as Rs ‘
20 and Rs 60 respectively and total profit of Truck
in April month is given as Rs 4200. Ratio of total
ride per day of an Auto to total ride per day of a car
is 3:2. Ratio of per ride profit of a Truck to per ride
profit of a car is 70:30 and total profit is given as Rs

~ 15980 per day.

56. What is-the difference in profit earned by all
Cars and Truck in one day‘7 :

a) Rs 13,660

'b)Rs 12,120

c) Rs 14,120

d) Rs 11,380

- 57.What is the ratio of profit earned by acarina
day to that earned by an Auto in a day?

\ a)ll: 9
< b)2:1
©.¢)8:9

7 d) 13:9

: '58 What 1s the total proﬁt of a smgle Car, Truck

and Auto in a day?
. a)Rs 4860
" 'b)Rs 4460

. ¢)Rs 4240

-d) Rs'5620

o

59, What is the contnbutlon of cars(approxmately)

54. Out of works A,B,C,D, which work aman takes+ 0 the total income per day in percentage?

most days to complete?
o a)A
- b)B.

c)C

dD
55. One Man, One Woman and One Chlld workmg
together get 1200 Rs in total for completing work A
and 600 Rs for completing work D. What is the
amount received by a child for completing both
works (in Rupees)? .

a) 200

b) 300

c) 400

d) 500

. a) 68%
- b) 72% "

L) 15%
: g d) 82%'

60 What is the total profit earned by all the Autos
in the month of April? -

g) 192,600
b) 162,900
c). 129,600
d) 169,200

\

BHKL/Eng/B-6
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Directions (Q 61 -65): The following bar graph “a) 10%
shows the Income and Expenditures (in lakhs) b) 20%
of five companies in the year 2001. c) 25%

The percent profit or loss of
Income—Expenditure
x 100.

Income

a company is given by d) 30%

: . 65. If the income of the Company Q in 2000 was
On the basis of the given dat: : N pany
questions, given data, answer the following 10% less than its income in 2001 and the

Company had earned a profit of 10 Lakhs in
Income and Expenditure {In La;;!;sj) of five coi'npanles in the year igi%s;]??en what was its expenditure in 2000(“1
a) 28
0| o b) 30
— 8 , SR Fen c) 32
. d) 26

50 45
a0

2 , . . M|-]1- | Directions (Q 66-70): The following table

10 M| il 7 | sives the percentage distribution of population

o iR RS | of five states: P, Q, R, S and T on the basis of
Y N p a. . om - poverty line and also on the basis of gender.

‘ On the basis of the data given in the table chart,

| answer the following questions.

m Expenditure Qlncome

61. What was the percentage profit/loss of the :

companies M and N taken together ? Proportion of
' E) 122/0 loss. | - 2. e 0 Males and Females _—
O 10% . oo e N N
d) There was no loss or profit. : ‘Poverty Line overty LinePoverty Line
62. In 2001, what was the approximate M; K P
percentage of profit/loss of all the five P 48 5:6 6:7
Companies taken together ? Q .20 3:5 4:'5
a) 4.65% profit. R 25 2:3 1:2
 b)- 6.5% profit. S - 19 332 4:5
c) 4% loss. T _10 5:3 3:2
d) 7% loss. R
: : _ : " 66. If the male population below poverty line
63. Which company earned the mgmmum - for the state R is 4 million, then what is the total
percentage profit in the year 20017 population of the state R ?
3 M : EE S a) 40 million.
b) N ‘ el - b) 48 million.
o Q . 3 - ¢) 50 million.
d P ‘ ~d) 60 million.

64. For the Company R, if the expenditure had

increased by 50% in year 2001 from year 2000 67. What will be the number of females above

and the income increased by 25% in year 2001 ¢ poverty line in the state S, if it is known that
from year 2000. Then what was the profit  * the population of the state S is 100 million ?
percentage in the year 2000 ? 5, ' a) 57 million.

b) 45 million.

BHKL/Eng/B-7
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¢) 36 million.
d) 48 million.

68. If the population of males below poverty -
line for the state Q is 2.4 million and that for

the state T is 6 million, then what is the ratio of

the total populations of the states Q and T ?

a) 1:3
b) 2:5
c) 3:7
d 4:9

69. If the male population above poverty line for the
state P is 12 million, then what is the total |
population of the state P?

a) 40 million
b) 50 million
¢) 60 million
d) 70 million

-70. Using the answers obtained from above four
questions, calculate the ratio of total population of P
to the total population of R? :

a) 3:5
b) 54
c) 5:6

- d) 6:7

'LOGICAL REASONING.

71.Ifina certaiﬁ code, TREE is written as UQFD, -

then how is LEAF Wri_tten in that code?

a) MFBG = i i ¢
b) MDBE $
c)- KDZE

d) MBZE

72. A man walks 1 km to East, then he turns to s
South and walks 5 kms. Again, he turns to East and
walks 2 kms. After this, he turns to north and walks-
9 kms. Now, how far is the man from the startlng
point ?

a) 3 kms.
b) 4 kms,
¢) 5kms,
d) 7 kms.

GET IT ON
Google Play

73. Using only 2, 5,'10, 25 and 50 paise coins, what
will be the minimum number of coins required to
pay exactly 78 paise, 69 paise and Rs 1.01 to three
different persons?

a) 19

b) 20

c) 17

- d) 18

74. A test has 50 questlons A student scores 1 rnark
for a correct answer, - - for a-wrong answer and - =

for not attempting a questlon If the net score of a

~ student is 31, and he has not attempted 6 questions,

then number of questlons answered wrongly by that

student is: :
i) a) 6 . ; 4 ' |

b) 12

e) 3% " . .

d 9

75. Here are some words translated from an

artificial language.

~ ‘dionot” means Oak tree
* ‘blyonot’ means Oak leaf
‘blycrin’ means Maple leaf -

; Whlch word could mean “Maple Syrup '

- a) blymuth

" b) hupponot -
c) patricrin ©
d) wellbly

76. If the word ‘EXAMINATION’ is coded as . §

561495 12965 then the word ‘GOVERNMENT 1s
coded as:

a) 764595,455_2

©'b) 7654694562

- €) 7645965426
d) 7654964526

77. A clock strikes once at 1 o’ cloék, twice at2 o’

~ clock and so on. If it takes 6 seconds to strike at 3 o’
" clock, then in an entire day of 24 hours. How much

time is spent on striking of the Clock?
a) 5 minutes 12 seconds
b) 4 minutes 6 seconds
‘c) 3 minutes 20 seconds
d) 5 minutes 32 seconds

BHKL/Eng/B-8
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78. There
numbers,

102
09 9 07

The left one is complete whereas one number is

111is§i11g in the right one. Find a suitable number to
fill in the place of the question mark,

a) 280
b) 303
c) 362
d) 382

are two similar figures below with some

79. Which number should come next in the series:
46, 44,40, 38 34
\

R %
b) 30
c) 32

~d) 36

80. The pair PETAL : FLOWER has certain-
relationship to each other. Select the pair
from the options given below w1th the same
relationship. '

a). Pen : Paper

b) Engine: Car . ¢ R i
¢) Cat: Dog : , 233
vd) Ball : Game :

Directions(Q. 81-85) Refer to the followmg data
and answer the questions that follow.

A numerical machine accepts two values X and Y
. Then it updates these values as : :
X=XY and Y =Y + 1 in every step.

The machine stops at X >N.

81.ForX=3,Y =2 and N = 100, what is the value
of Y when the machine stops?

a)2
b) 3
c)4
d)6

GET IT ON
Google Play

82. In the above question, what is the final value of
X when the machine stops?

a) 6

b) 20

<) 72

d) 360

83. In the above question, what is the value of X
after Step 17 ‘
a)4
b) 5
c)6
d) 20

84. If the value of N is changed to 500, what would

~ be the final value of X?

2) 3160
b) 2500
c) 1560
d) 2160

 85.1f X =2,Y =3 and N=500, what would be the

value of X when the value of Y-is 7?
2)300
b) 360
¢) 720
" d) 860

86. Compiéte the series: |

CKDL, EKFL, GKHL,__,
from the options given below.

a) IJKL
" b) MNOP*
c) MNPQ'’

- d) IKIL

KKLL

87. The pair PAIN :SEDATIVE has certain
relationship to each other. Select the pair

- which has the same relationship.

'a) comfort : stimulant
b) grief: consolation
¢) trance : narcotic
d) "ache : extraction

88. Pointing to a woman, a man said, "Her
father is the only son of my father." How is
the man related to the woman ?

a) Brother
b) Grand father

BHKL/Eng/B-9
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c) Father
d) Son

89. Arrange the following words in a meaningﬁﬂ
sequence.

1. Cow 2.Grass 3.Milk 4. Curd
a) 1,3,2,4
b) 4,3,2,1
c) 3,4,1,2
d) 2,1,3,4

90. A man walks 5 km toward south and then
turns to the right. After walking 3 km, he
turnsto the left and walks 5 km. Now, in -
which direction is he from the startmg place?

a) South

b) South-West
c¢) North-East
d) West

91. Pick the odd one out from the given palr of
words.

a) Docile: Submissive
b) Stringent : Flexible
¢) - Steadfast : Irresolute
d) Monotonous : Exciting -

92.If "HARYANA" is written as "8197151"
in a certain code, then how is "DELHI"
written in that code ? . 41y
a) 53289
b) 45389 °
. ¢) 34589
d) 56789

. 93. Choose the letter pair Wthh is dlfferent from ‘

others in the group. "
b) IK - =5

c) PN

d) SU -

94, Find the missing leters in the series:
DFH, HIL, LNP, , TVX
. from the options given below.

a) DTV
b) NRT -
¢c) PRT
d) RQS

GET IT ON
Google Play

95. Rita told Mani “The girl I met yesterday
at the beach was the youngest daughter of the
brother of my friend’s mother.” How is the
gitl related to Rita’s friend ?

a) Cousin

b) Daughter

. ©) Mother
d) Aunt

" 96, Ram is facing north. He then turns 45° in the

clockwise direction and then again turns 180 in the

same direction.. He then turns 45° in the ansi— '
clockwise direction. Find the direction he is facing
now ?

‘a) East

b) West
c) North
d) South.

97. A dice is numbered from 1 to 6 in different
ways. If 1 is adjacent to 2, 3 and 5, then which
one of the following optlons is necessanly true ?

a) 1 is adjacent to 4.

b) 2 is adjacent to 3.

¢) 1 isadjacentto 6.

. d)- 4 is adjacent to 6

. Dlrectmns (Q 98-100) Read the passage glven

below. and pick out the correct optlon for the- glven
questions. »

Five roommates Ranveer Salman Tiger, Upen

and Varun each do one housekeepmg ‘task:

, moppmg, sweeping, laundry, vacuuming, or

dusting one day a week, Monday through
Friday. -

» Varun does not vacuum and does not do his task on
Tuesday. -

« Salman does the dusting, and does not doiton
Monday or Friday.

» The mopping is done on Thuisday

« Tiger does his task, which is not vacuummg, on

Wednesday

« The laundry is done on Friday, and not by Upen.
: Ranveer does his task on Monday.

98 Which day does Upen do his task 2
a) Friday
-b) Thursday
c) Tuesday
d) Monday
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¥¥. What task does Upen do?
" a) Mopping
b) Laundry
¢) Sweeping
d) Dusting

100. Which day does Salman does his task?
a) Friday
b) Thursday
¢) Tuesday
d) Monday

ARITHMETIC |

101. What is the value of the followmg
expression:

[26+ {42 (23 —20) +2 ~(2 x (5 x80 —100))
+16 —4}1? ‘

a) —434-
b) 434

c) —443
d) —453

102 What is the number When multlphed by 16
increases by 540 2

a) 30

b) 36

c) 42

d) 46

103. What is the dlfference in the place value of 5 1n

the numeral 754853,7
a) 45000
b) 49500
c) 49940
- d) 49950

 104. If two-third of three-fourth of a .
number is 34, then what is the value of .
20% of thatnumber ?

' a) 13

b) 13.6

c) 14 -

d) 14.6

105, If x = 0. 84181 is expressed as a fraction in
the lowest terms, then the denominator exceeds
the numerator by:

a) 15803

" b) 18503
c) 13580
-d) 10583

GET IT ON
Google Play

106. The approximate value of
0.4 x0.4+0.04 x0.04 + 0.04 is:
a) 0.16
'b) 0.20
c) 0.38
d) 0.46

107. The population of a town is decreasing at a rate of
10% per annum. If the population 2 years ago was
20, 000, then what is the present population ?

a) 15,000 '

b) 15,200

c) 16,000

d) 16,200

108. Anil’s salary was Rs.18, 000. An increase of

~ 20% each in two consecutive years is equal to a

single increment of what percentage ?
a) 22% .
b) 32%
c) 40%
d)- 44%

- 109. A certain amount of mohey was invested on
- simple interest at a certain rate for 2 years.If it had
.. been invested at 4% higher rate, then it would have -

fetched Rs.480 more, then what is the amount of

- money invested?

~a) Rs.6,500
b) Rs.6,000
c) Rs.5,600
d) Rs.5,300
110. On lending a certain sum of money on
compound interest, one gets Rs.9050 in 2 years -
and Rs.9500 in 3 years. What is the rate of
interest (approximately)?
a) 6% :
b) 5.5%
c) 5%
d) 4.5%

111. X’s and Y ’s shares in a business are in the

ratio of 5 : 3. If X has invested Rs.70, 000 for 12

-months, then for what period of tlme Y has

invested Rs.60, 000 ?
" a) 64 months' :
b) 7.4 months
c¢) '8.4 months
d) 9.4 months
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u 112. The sum of the present age of mother and 118. A mai purchases a TV for Rs.8, 000 and sel{; ,
her son is 60 years. Six ycars ago, the age of the it at 10% loss. What is the selling price of the T
mother was five times the age of her son. What a) Rs.7,200
will be the age of her son after 6years? b) Rs.7,000

a) 23 years c¢) Rs.6,900
5 21 yours O h a destination by
c) 21 years 119. A car takes 2 hours to reac/ha e
d) 20 years travelling at the speed of 60 km/hr. How long .
hours) will it take when the car travels at the spee
113. The day on 5™ April of a year will be the of 80 km/ilr?
same day on 5th 4f which month of the same year a) 1 n
? | R
.a) 5t June ' 51 f
b) _Sth July . ‘ 9 135

o) sth August
d) 5t October | 120. A train is moving at 120 knm/hr. The length
' ‘ of the train is 150 meters. How long it will take

to cross a platform of length 100 meters ?
a) 7.5 seconds.
b) 10 seconds.

~ - c) 20 seconds.

114. A man swims 12 km downstream and 10 km
upstream. If he takes 2 hours each time, then
what is the speed of the stream ?

a) 1.5 km/hr.

b) 1.7 km/hr. d) 25 seconds.

c) 0.7 km/hr. 121. P can do'a job in 12 days and Q can do the
d) 0.5 km/hr. same job in 10 days. With the help of R,they -

can do the same job in 4 days. In how many days

'115. How many times the hands of a clock commde R alone can do this job ?

in a day (or 24 hours) ? o a) 12 days.
a) 24 , , e , - b) 13 days.
b) 23 ' : 5 e : c) 14 days.
c) 22 : ‘ . . d) 15 days. :
d} 21 A oy & C122.A shopkeeper mixes 60 kg of sugar priced
. w B E j - Rs.30 per kg with 90 kg of sugar priced Rs.40 "
116. Sachin ecored a century which included 3 o o At what rate he must sell the mixture to-
fours and 8 sixes. As a result, what percentage-of- gain 20% ? ‘
hjs total score did Sachin score by running i . a) Rs.30 per kg
between the wickets ? g b) Rs.34 perkg.
a) 40 - _ T . ¢), Rs.38 perkg.
b) 45 ‘ S : e ~d) Rsd3.2 perkg.
c) 50 ; o : i '
d) 55 A e ) 123 it (V3)S x 9% = 3 x 34/3, then x equals to:
| R a3
117. A pipe can fill a tank in 6 hours and another 'b) 4
pipe can empty the tank in 12 hours. If both the - 3)) 2 ;
pipes d at the same time, then the tank |
zai bearf;loieneh 2 mina heire ¥ cRHeTant 124, The LCM of two prime numbers x&y is 161.
€d i how Y ' : , If x >y, then the value of 15y —7x is: ~
a) 10 hours _ v ‘ a) —32
b) 12 hours ihy b) -56
¢) 14 hours : : ; c) 38
d) 16 hours - d) 74
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125. A blanket, when bleached, decreases in

> COMPUTER AND INTERNET AWARENESS
length by 20% and in breadth by 15%. What is

the percentage decrease in its area ? 131. IPv4 address is:
a) 32% a) 8bit
b) 35% b) 16 bit
c) 42% c) 32 bit
d) 45% d) 64 bit
126. A bag contains Rs.410 in the form of Rs.5, 132. Which of the following is used to create or
Rs.2 apd Re.1 coins. If the number of coins is in design a web page?
the ratio 4 : 6 : 9 respectively, then what is the - a) HTML
number of 2 rupees coins ? b) HTTP
a) 40 c) PPP
b) 50 d) WWW
c) 60 :
d) 70 133. An identifier that sends and receives
_ " information across the Internet is called:
127. In a 100 meters race, P covers the distance a) IP address
in 36 seconds and Q covers in 45 seconds.In this b) www
race, P beats Q by: A c) Network
' a) 9 meters. : d) URL
b) 20 meters. _
c) 22.5 meters. ' 134. What is the full form of NIC? .
d) 25 meters. o . ' a) Network Interconnection Card
' b) Network Internet Card
128. How many numbers from 1 to 20 are either g) Network Literface Card
a multiple of 3y0r 572 : d) Network Inira Carc
a) 9 135. Wh1ch view allows to modlfy table’s
b) 8 structure in Access?
c) 6 . .a) Design view
d 5 - ' s " b) Datasheet view
F ' ] _ c) Pivot table view
129. What is the length of the longest rod that can - d) Pivot Chart view
“be placed in a room 30 meters long, 24 meters
broad and 18 meters high ?* - = 136. Which key stroke moves the active cell
' ' e - towards left in Access table?
.~ a) 30 meters. e a) F2
b) 15V2 meters. R Ly b) F5 -
c) 3072 meters. - ' 'c) Tab

d) 60 meters. d) Shift + Tab . -

130. The numerator of a fraction is 3 less than the

denominator. If the numerator be made 3 times - content of active cell in Access table?
and 20 is added to the denominator, the fraction - a) Ctrl+F2

becomes %- What is the fraction? - b) Ctrl+F5
' - c¢) Shift + F2

137. Which combmatxon of key zooms the

- a) ‘_1} A -d) Shift +F5
b) 2 ' _
: g 138. In MS Access, form dialog may be created
c) 5 ‘using menu.
d) 4 . a) Create>More Forms>Form
7 Wizard

b) Create>More Forms>Data Sheet
. BHKL/Eng/B-13
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c) Create>More Forms>Modal
Dialog
d) Create>Blank Form

139. To open the existing presentation, press:
a) Ctrl + L
b) Ctrl + N
c) Ctrl + A
d) Ctrl + O

140. The File that consists of readymade styles that
we can easily use for our presentation is known as:

a) Pre formatting
b) Template

c) Wizard

d) AutoStyle

141 In Microsoft PowerPoint in order to see all the
slides on one screen use:

e

a) view slide sorter

b) view slide _
© c) view master

d) view slide show

142. Wh1ch is the menu command to recolor a :
picture on a slide? :

a) Insert -> Picture -> Recolor -

b) Tools -> Picture -> Recolor -

c) Format -> Picture -> Recolor

d) Edit -> Picture -> Recolor - N

- 143. How can you update the values of formula -
cells if Auto Calculate mode of Excel is dlsabledV
a)F8

- b)F9

¢) F10

d)F11

144. You can convert existing excel worksheet data
and charts to an HTML document by usmg
a) FTP wizard
b) Internet assistant wizard
©) Intranet wizard .
Import wizard

GET IT ON
Google Play

145. What is the short cut key to highlight the entire

‘column in Excel?

a) Ctrl +C

b) Ctrl + Enter

c) Ctrl + Page Up
d) Ctrl + Space Bar

146, Which of the following is an examplc of Page
Orientation? ,
a) Landscape

b) Subscript

c) Superscript

d) Ad

147. You can Select all the text in MS Word
document by:

a) Ctrl +S

b) Ctrl +'A

c) Ctrl+V

“d) Ctrl + 1

~ 148. How can you apply exactly the same

formatting you did to another text in MS-word?

. a) Copy the text and paste in new locatlon Then

type the new text again ,

b) Copy the text and click on Paste Spec:1al tool in
new place -

c) Select the text then click on Format Painter and
select the new text g
d) All of above

149. To use your keyboérd instead of the mouse to

‘select tools on the nbbon you dlsplay the KeyTips

by pressing the -~ - key
a) Alt

b) Ctrl

¢) Shift + Enter
d) Alt + Enter

* 150. If you need to change the typeface ofa

. :document which menu w111 you choose?
a) Edit

b) View
c) Format
d) Tools .
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